
An Excel Primer 

Excel will be used in several labs throughout this course. This primer provides information on how to do 

some of the things you’ll need to do.  Remember that you can also reach out to your TA or lab group for 

help.  

The examples in this primer are designed to work with Excel for Windows.  If you use Excel for a Mac or 

in a browser some of the functionality and ways to access it may be different. 

Acquiring and getting help with Excel 

1. To acquire and run a local version of Excel go to https://is.oregonstate.edu/microsoft.  Click 

download office then install it: This will also give local access to other Microsoft products such as 

OneNote and Word.  

2. If you are having trouble accessing the Excel, contact the OSU help desk at 

https://is.oregonstate.edu/service-desk.  

Working with data 

Importing data 

Importing data is necessary for most of the things you will be doing with Excel. Here are some 

instructions for doing so. The menu options may slightly vary depending on the version of Excel that you 

are using.  

1. Open a blank workbook in Excel. 

2. Copy your data from your source and paste it into Excel.  

   Or  

1. Click on the Data tab. 

2. Click on the New Query icon.  

3. Click on the From a File icon.  

4. Select the option most appropriate for the data you are trying to import. Generally, data from 

analytical instruments such as the force probe on your cart can be saved as a .CSV file that imports 

with few problems to Excel.  

https://is.oregonstate.edu/microsoft
https://is.oregonstate.edu/service-desk


An Excel Primer 

5. After selecting the file click Open 

Formatting Cells 

Sometimes copying data into Excel will result in the data being in a format that cannot be used in Excel 

formulas.  

1. After copy/pasting data into Excel, Highlight the columns containing the data. Right click and select 

Format Cells.  

2. A menu will pop up. Here, you can select the Category of data for the column. In order to use the 

data for Excel Formulas, you should select Number and then click "OK".  

 

Cell references  

Cells are labeled by giving the column (labeled by capital letters) and the row (labeled by a number).  For 

example, the cell in the second column three rows down is labeled B3. Excel cells can hold a variety of 

types of data such as numerical values, dates, texts, and formulas.  

• Cells in Excel hold numerical values, as well as other types of values such as text and dates, as 

needed. 

• Any cell reference preceded by a dollar sign is an absolute reference that will not change if references 

to the cell are, for example, copy and pasted.  

o For example, $B4 will always refer to the second column of the spreadsheet, though the row (4) 

may be updated if used in an Excel formula. B$4 will similarly always refer to the fourth row, 

though the column may be updated if used in an Excel formula. $B$4 will always refer to the 

second column and fourth row of the spreadsheet, no matter what. This can be a handy way to 

store "constants" that have to be reused repeatedly elsewhere in the spreadsheet.  

Formulas 

Formulas in Excel can be used to calculate a value in the selected cell by substituting values from other 

cells and performing mathematical operations. For example, if the distance traveled is in cell D4 and the 

time it took is in cell C4, you can have Excel calculate the average velocity over that time interval in cell 

D4 by entering "=D4/C4" in cell E4. Formulas always begin with an "=" sign. 

a. You can insert formulas by typing directly in the cell or by selecting the cell and entering the formula 

in the "formula bar", the text field just above the C and D column headings in the image above. 
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b.  Exponents are entered using the carat ^ character.  For example, to calculate the cube of the value in 

cell A17, enter "=A17^3" in whichever cell you would like that value to appear. 

c. Excel has many built-in functions that can be used for calculations such as trigonometric functions, 

exponentials and logarithms, statistical functions, and many more.  Their properties are well 

described in Excel's help, and you can investigate what's available using the Formula Builder 

available at Insert > Function… 

d. If you have a long set of columns in which the same calculation must be performed but with different 

values in each row, you can "drag down" a formula and Excel will copy the formula into every cell in 

the column you drag over intelligently updating the cell references. (Any absolute references, as 

defined above, will not be updated.) 

e. To drag a formula down, click on the cell containing the formula to select it.  Hover the cursor over 

the bottom right corner of the selected cell until a small square appears just on that corner.  Click on 
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the square and drag the formula down over all the cells in which you wish a (suitably updated) copy 

of that formula to appear:      

Numerical Analysis Skills 

Numerical analysis is the use of algorithms to computationally compute a result.  Excel, which offers a 

variety of tools to analyze the data collected in labs.  

Finding Slopes (aka Derivatives) 

1) A derivative is the slope of a tangent line at a given point on a graph. It tells you about how one value 

changes with respect to the other. For example, the slope of position with respect to time tells you 

how the position of an object changes for a given amount of time, or in other words the velocity of an 

object.  

2) Slope is calculated by dividing the change in the values plotted on the vertical axis over the change in 

the values plotted on the horizontal axis. The equation below gives an example for calculating the 

slope between two points: (x1, y1) and (x2, y2).  

slope between (x1, y1) and (x2, y2) = (y2 – y1) / (x2 – x1) 

3) Consider some sample data below. The time (column A) and position (column B) of an object at that 

time has been recorded in the spreadsheet. The next step is to calculate the slope (which would be the 

velocity of the object) for each data point. In this example, you would start by calculating the slope 

for time t=0s. In cell C2, type “=((B3 - B2)/(A3-A2))”. This finds the change in position and divides 

that by the change in time between data points. This calculates the slope according to the formula 

above.  

 

4) The velocity (slope) has now been calculated for one point. Click on the cell where the derivative was 

calculated, click on the green box in the bottom right-hand corner and drag it down to the second-to-

last cell. Excel defaults to empty cells in formulas being zero, which means if you drag the formula 
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down Excel will give you a value for the velocity but it will not actually be a true value. The slope for 

that last data point cannot be calculated because the position is not known for time t=11s. This means 

that we don't have data to use for the slope formula. 

Finding Areas Under a Curve (aka Integrals) 

The "integral" of a function is the area under its curve between two points.  If you have taken calculus, 

you may be familiar with the notation for an integral:  𝛥𝑣 = ∫ 𝑎 𝑑𝑡
𝑡2

𝑡1
.  This equation says that the change 

in the velocity between two times t1 and t2 is the area underneath the acceleration curve (as a function of 

time) between those two times.  Here's an example of how to find the change in the velocity from the 

acceleration vs. time by finding the area under the acceleration vs. time curve. 

There are several methods of finding areas (integrating data) in Excel: 

• The midpoint rule estimates the area under the curve as a series of pure rectangles (centered on the 

data point). As you can imagine, this results in poor accuracy when the data (integrand) is changing 

rapidly. 

 

• The trapezoidal rule estimates the area under the curve as a series of trapezoids. This greatly increases 

the accuracy, regardless of the change in the integrand. To calculate the velocity at any given time, 

we need to calculate the integral of acceleration over time. Since we have a limited number of data 

points, the trapezoidal method will give us the greatest accuracy for our calculated velocity and 

position data. This is what we suggest using in lab.       

 

Note that the plots above demonstrate the areas that a midpoint/trapezoidal rule use to calculate the area 

under the curve. They do not represent what an area under the curve plot looks like. The area under the 

curve plot will look like any other scatter plot you produce. 

  



An Excel Primer 

Consider a dataset that looks like the following. We have acceleration data and we want to get the 

velocity at each time by finding the area under the acceleration vs. time curve up to that moment.  

We need to calculate the area of the first trapezoid, which is given by  

{[a(𝑡 = 0.02) + 𝑎(𝑡 = 0.06)]/2} ∆𝑡, 

where ∆t is the base of the trapezoid, and a(t=0.02) and a(t=0.06) are the top corners of the trapezoid.  

a. We can calculate the base of the trapezoid ∆t, the change in time between cells, by using the formula 

“=(A3-A2)” in cell C3.  

b. Next, we need to calculate the average of the heights of the trapezoid. We will do this by averaging 

the acceleration at two adjacent point resulting in the formula ((B2+B3)/2).  

c. The area of the trapezoid is the base times the average of the heights. This gives the formula  

d.  =(A3-A2)*((B2+B3)/2). This is the area of the first trapezoid that is width Δt.  

e. An integral sums the area of all of these trapezoids that we are calculating. In cell C3, we will need to 

add the area in C2.  In cell C4, we will need to add the area in C3, and so on.  So in our formula we 

add the area from the previous calculation.  In cell C3 type “=(A3-A2)*((B2+B3)/2)+C2”. Remember 

to pay attention to parentheses.  

• Leave the first area cell, C2, blank, since there’s no previous time to use. 

f. Now drag the formula in C3 down to the last time, t=0.54s. Column C now contains the velocity of 

the object at each time!  (Strictly speaking, it contains the change in the velocity from the initial time, 

which is exactly the velocity at that time if the initial velocity was zero.  We cannot calculate the 

velocity at time 0.54s because we do not have data about the acceleration at the next time, 0.56s.) 

Now you have data about the velocity at each point in time, except for the very last time recorded. 

This data can then be plotted.   
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Plotting and Fitting Data 

Each lab will require you to visualize the data you've collected. Graphical Analysis will often plot things 

for you, and fitting data in that program is relatively easy. You will also be asked to generate plots in 

Excel as well. This will guide you on how to create scatter plots, the most commonly used plot for the 

labs you will be doing.  

1. In Excel, drag and select all of the data that you want to plot. For ease of plotting, your independent 

variable (in most cases, time) should be to the left of your dependent variable (position, for example).  

2. Select the Insert tab. In the section titled Charts select the scatter plot icon shown below. 

3. You should usually choose the default scatter plot, with unconnected points.  Only choose the one 

with lines if you need to better visualize where the points are.  Don’t choose it if, as is usually the 

case, you’re going to fit the data with a curve.  Whatever you choose, your data points should be 

visible. 
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4. Always add a title to your plot and appropriate axes labels. To do this, click on the plot. In the Design 

tab, on the left you will see an option to Add Chart Element. Clicking on this will allow you to add 

a plot title, axes labels, and more. Alternatively, when you click on the plot a green plus sign will 

appear on the top right corner of the plot. Clicking on this will reveal a menu where you may select 

what elements you want on the plot. For example, if you have two lines plotted you will want to add a 

Legend to the plot.  

 

5. Often you will want to include a trendline on your plots to get a value of the slope of the line or other 

parameters. If you click the Trendline option, a linear trendline will appear on the graph and an 

arrow will show up next to the check box in the chart elements section.  Click on More Options. 
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6. Now you can select the type of fit you want (linear, logarithmic, polynomial, etc.). You should also 

select the option Display Equation on Chart to get the fit parameters, such as slope and the intercept 

of the data.  

Plotting multiple data sets 

You can easily plot more than one set of data on the same graph if they share the same x-values.  To do 

so, arrange the data so the x-values are in the first column.  Each column after that should include one set 

of data to plot.   

1. Select all the columns containing data. 

2. Insert a graph, as before.  Your new graph should have multiple data sets in different colors and 

shapes.  
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Notice that the graph now includes a legend (upper right), identifying each set of points.  You can reshape 

the legend as well as change the colors and styles of the points. 

3.  You can also use different y-axis scales for the data sets.  Right click on the data set, select “Format 

Data Series”, and choose “Secondary Axis.”  The data will be plotted using the scale on the right, 

rather than the scale on the left. 

 


